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/
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PUUMMER MIL

Workbench 2 possible locations found
| Georeference Options Clear Polygon |

Draw polygon
Locality String: Lisbon Falls

UNITED S

Place marker Measure

¥ latitude: 44.008043
44.0086043

¢ longitude: -70.057947 ¥ uncertainty: 2504 m ¥ error polygon
-70.0857247 2504
Maine

143.9905800243,-70.0514999006,43.9905810243, -70.0515509006,43.9908840243,
70.052443%006,43.9915970243

0.9534149006,43.9926080243,-70,0563309006

-69.997586, 44.020136
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] PART 4: GEOREFERENCING IN EMU




SITES: SPECIMEN DATA ENTRY

Locality Tab

Higher Geography
-Controlled vocabulary
-Look-up lists
-Auto-fill

Precise Location:
«VVerbatim from label

Elevation: enter if provided
(auto converts from meters >
feet or vice versa)

Township, Range, Section (TRS):
enter if provided on label with
T, R, S preceding the
value/direction (i.e. T24N)

KE EMu (NYBG) B
— i
% Catalogue ‘ :,_,_,";"'— Taxonomy ‘ E Propagation )ﬁ Sites ) }
LY Sites (1) - New =|@] X
File Edit Select View Tools Tabs Multimedia Window Help
DE&® B ® g (5 2
| | 923140
Locality Details Blevation (Above Sea Level)
Ocean: | = From: {metres) feet)
Continent: | i Ta: {metres) feet)
Country: | i Prefoc: |
Province/State/ Temtony: | i Accuracy: |
Diigtrict County./Shire: | i Detemination Method: | ﬂ
City/ Town: | i Locality Details {cont )
Mearest Named Place: | i Township: |
Special Geographic Unit: | = Range: |
Precise Location Section: |
Site Size
( Locality /j) Lat/Long ] Mapping MNotes ] Multimedia ] Security ] Admin
Mew Site 1 of 1 watson | 20085

For help see the Sites Wiki



https://sweetgum.nybg.org/wiki/index.php?title=Sites_Module

SITES: SPECIMEN DATA ENTRY

L Sites (3) - Display (=] E -t
File Edit Select View Teools Tabs Multimedia Window Help
O BERD ZEY BEEEBE « « »n B & »?

|hku1h America. United States of America. Montana. Carter Co.. The Great Plains. 9.4 km W of Camp Crook. 5. Dak. [Scouth Dakota] or 31.4 km | 397365

LatitudeLongitude Details

Latitude (DMS) | Longitude (DMS) Latitude (Dec.) | Longitude (Dec ) | Latitude Verbatim | Longitude Verbatim |Modi_ |Comment |
|1[452024.000N 10402 W 4534 -104.05 45202400 104 2 0.00W
]
Detemination Source: Label i Radius I,‘-Ierbatim}:l Probability: |
Detemination Method: [ i Radius (Mumeric): | Units: | ﬂ
Determined By: | Geometry: | Diatum: | j
Determination Date: | Derive Centroid: ' System  User Prefemed: |Yes ﬂ
Centroid Lattude (DMS): [45 20 24 N Dec.:[45.340 Centroid Longitude: [104 03 0 W Dec.:|-104.050
Motes:
Latitude,Longitude List

Determination Source Centroid Latitude (ODMS) Centroid Longitude Prefemed

45 2024 N 104 030W

]Nd&s]Mﬁneﬁa]Seaﬂy]Mﬁl]

e
Display | Site 15 of 859 watson | 20085

Determination Source for coordinates = Label
Calculated/converted values appear in Red
Verbatim Fields: data as it appears on the label
(with/without errors and/or modifiers)



ol Sites (5) - Display

SITES: IRN

File Edit Select View Tools Tabs Multimedia Window Help
DEHOBRRBD DY BREEE « « » B 0|
IHnrth America, United States of America, Montana, Bozeman 273568 |
—Localty Details —Elevation (Above Sea Level)
Ocean: ﬂ From: {metres) feet)
Continent: North America H RS (metres) ffeet)
Courtry; United States of America il Prefie:
Province/State/ Temtany: Maortana il Accuracy:
District/County//Shire: =| | | Detemination Method: |
City/ Town: ﬂ —Locality Details (cont.)
Mearest Named Place: il Township:
Special Geographic Unit: 5 Range:
—Precise Location Section:
Bozeman —Site Size

Display | Site 20 of 41

watson | 20085 E

S

F4

Show Attachments

Internal

Record Number (IRN)

Unique Identifier



SITES: ATTACHMENTS

Lol Sites (5) - Display (o] B

File Edit Select View Tools Tabs Multimedia Window Help

O BRO Y BEEREEREE « « » 0 B @ w2
|North America. United States of America. Montana. Bozeman | 273968

Collection Events
ﬂE. J. Moore s.n., Morth America, United States of America, Montana, Bozeman [+

2|P. A Rydberg 2677, Marth America, United States of America, Morntana, Bozeman
3 |F. L. Scrbner 184, Morth America, United States of America, Montana, Bozeman

Locality ] Lat/Long Mapping ( |“Coii Everts | ) MNotes Muttimedia ] Security ] B gy
e ——
Display | Site 20 of 41 watson | 20085

CAUTION

Always be aware of the ONE to MANY collection event records
that will be affected by ANY changes made to a sites record.




LATITUDE/LONGITUDE DETAILS

Fle  Edit 3EIeCT  Wiew [fududiy laps  nidinimeoia wWindow  HRep

DE® BRD 25 Y M o4 > B R
|South America. Argentina. Cérdoba. Vicinity of Cosquin, Cordoba | 1400388

LatitudeLongitude Details
Latitude (DMS) | Longitude (DMS) Latitude (Dec.) Longitude (Dec ) Latitude Verbatim | Longitude Verbatim |Modifier |Comment | 1)

311447355 470304]

1]
¥

Detemination Source: i Radius |_"-Ier|::atim}:| F‘n:ul:ual:uil'rt},':|

Determination Method: E Radius [Numeric}:| Lln'rts:| ﬂ

Determined By: Ge::nme‘tr'_.':| Datum:| j
=l

Centroid Latitude (DMS): Dec. Centroid Longitude: Dec. |

Motes:

|
|
|
Determination Date: | Derive Centroid:  © System {+ User F‘referred:|‘l’-3$
|

LatitudeLongitude List
Determination Source Centroid Latitude (DMS) Centroid Longitude Prefemed

| Ve

Lat/Long tab

 Locaity ( Latlong | ) Mapping [ Netes | Muimedia | Secuy |  Audt | Admn |

Enter coordinates into Latitude (Dec.) and Longitude (Dec.)
Derive Centroid: System (default)
Preferred: Yes (default)




DETERMINATION SOURCE

K

| FIE BT 3ElECT  VIEW 100l |38Ds  MULmMedida  window  Help
D& B RO &Y 4 4 » b m [ N2
|50uth America, Amgentina, Cordoba, Vicinity of Cosquin, Cordoba _ M Lookup Selection.. W 0388

Latitude/Longitude Details

Latitude (DMS)

| Longitude (DMS) Latitude (Dec.) | Longitude (Dec.) |Li | Look For: Google Maps {map data 2020); MaNIS Geon

311447358

u
bl

Determination Source:
Determination Method:
Determined By:
Determination Date:
Certroid Latitude (DMS):
Motes:

LatitudeLongitude List

6428 13.09 W 31246486 64 470304

T

Google Maps
Google Maps (map data 2013)

Google Maps (map data 2014)

Radius (Verba Google Maps (map data 2015)

Geom| |Google Maps (map data 2016); MaM|5 Georef. Calculator

Google Maps (map data 2017)

|

|

| Derive Centroid| | =0 le Maps {map data 2017), Manis Georef. Calculator

| Dec.: Cer |Google Maps {map data 2017); MaMI5 Georef. Calculatar
Google Maps imap data 2018), Manis Georef. Calculator

Google Maps (map data 2018); MaNI5 Georef. Calculator

Google Maps (map data 2015)

Detemination Source

] | Google Maps {map data 2020}

Google Maps (map data 2013); MaMIS Georef. Calculator
Google Maps (map data 2014); MaMIS Georef. Calculator

7

= s Google Maps (map data 2015); MaMI5 Georef. Calculator
# Radius (Mg Google Maps (map data 2016). Manis Georef. Calculator
[

Google Maps (map data 2015), Manis Georef. Calculator
Google Maps [map data 20159); MaM|5 Georef. Calculator

" OK

f

L]

f

x Cancel |

Provide the paper/online gazetteer, version, and appropriate
details. Be specific enough so that others can easily locate and use

the same resources in the future.

Include: publisher name, map date, map scale, map name




DETERMINATION METHOD

PHE Lui gfitan veeer  ien3 1O Gediid S VTRIGLWY  §
ODE® B3RO &4E5Y M o4 > M B & s
|50uth America. Argentina. Cordoba. Vicinity of Cosguin. Cordoba _ M Lookup Selection... %

LatitudeLongitude Details 1

Latitude (DMS) | Longitude (DMS) Latitude (Dec.) | Longitude (Dec.) |i| Look For: Georeferencing Quick Referencing Guide (Zemon

101311447355 64 28 13.09 W -31.246436 54 470304

#]

Detemination Source: |G-:u:|gle Maps (map data 2020); MaN|5 Georef. Calculat i Radius (Verba

Detemination Method: | = Radius (Nume

Determined By: | Geom

Determination Date: | Derive Centroid

|

Centroid Latitude (DMS):
Motes:

LatitudeLongitude List
Determination Source Centroid Lz
Google Maps (map data 2020); MaM|5 Georef. Calculator

& OK x Cancel |

Cite the formal protocol you followed to determine
the georeference (coordinates and uncertainty):
Georeferencing Quick Reference Guide, Version 2020



DETERMINED BY AND DATE

e ECit SJEIECT W IEW 1OOIE laps rIdItimecna VY INCow REp
DES® B ™D 2 (Y 4 4 » M B & K2
|South America. Argentina. Cordoba. Vicinity of Cosquin. Cérdoba | 1400388 |
Latitude/Longitude Details
Latitude (DMS) | Longitude (DMS) Lattude (Dec.) | Longitude (Dec.) | Latitude Verbatim | Longitude Verbatim |Modifier |Comment |
1[311447355 6428 13.09 W 31.246486 £4.470304
bl

Determination Source:
Determination Method:
Detemmined By:
Determination Date:
Centroid Latitude (DMS):
Motes:

Lattude/Longitude List

|G|:u:u;|Ie Maps (map data 2020); MaMI5 Georef. Calculat j Radius |_"-.."er|:|atim}:| Prcul:ual:uil'rt'_.':|
Georeferencing Quick Reference Guide, Version 2012 %| Radius [I‘\Iumeric}:| Lln'rts:| ﬂ
Perzon - L. Li (Lin Li); Collector, Project Manager, Geore _[ﬂ [+ Genrnetr'_.':| Datum:| ﬂ

Derve Centroid: © System (* Lser Preferred:|TE$ j

Detemination Source

1

1]

Google Maps imap data 2020); Mal 19 E:, ral

| X
ki a

0 29 30 31 1 2 3 4

5 & 7 3 9 10 1M

12 13 14 1% 16 17 18

22 23 24 %

26 27 28 29 30 1 2

i 4 5 & 7 g 5

c.:| Centroid Longitude: Dec.; |

Centroid Latitude (OMS) Centroid Longitude Prefemed

T'E:s

Determined By: attach your Parties Record
Determination Date: DD MM YYYY




RADIUS (NUMERIC)

Fiie  kdit  select View  lools  labs  hMulbimedia  Window  Help

ODE® BB D & (3 4 > b B & N
|South America, Argentina, Cérdoba, Vicinity of Cosquin, Cordoba | 1400388
Latitude/Longitude Details
Latitude (DMS) | Longitude (OMS) Latitude (Dec.) | Longitude (Dec.) | Latitude Verbatim | Longitude Verbatim |Modifier |Comment |
11311447355 64 28 13.09'W -31. 246486 -64. 470304
il
Determination Source: |GDDI;|IE Maps (map data 2020); MaNIS Gearef. Calculat i Radius I_"-Ierl:uatim}'l F‘n:ul:ual:uil'rt'_.':|_
Determination Method: |Genrefereru:ing Quick Reference Guide, Version 2012 i Radius (Numeric) |13_'§ 569 =i |E _j
Determined By: |F‘emu:un - L. Li {Lin Li}; Collector, Project Manager, Geore @l Genmetr:.-:l aturn:i j
Determination Date: |'|1 Mar 2020 Derive Centroid: { System (% LUser Prefemed: |TES j
Centroid Latitude (DMS): | Dec.:l Centroid Lnng'rtude:l Dec.: |
Motes:

Latitude,Longitude List

Detemmination Source Centroid Latitude (OMS) Centroid Longitude Prefemed
Google Maps {map data 2020): MaNIS Georef. Calculator I N .

Radius:
or is not applicable (because there are no
coordinates). Zero is not a valid value for this
term.

- Units:

leave empty if unknown, cannot be estimated,

meters



DATUM

rne Coic JIEIECL Ve 100 =143 PadiLimeEdd VINOow e

DEE® B ®D 2 3¥ M4 > B & )
|South America. Argentina. Cérdoba. Vicinity of Cosguin. Cérdoba | 14003
LatitudeLongitude Details
Latitude (DMS) | Longitude (DMS) Latitude (Dec ) | Longitude (Dec ) | Latitude Verbatim | Longitude Verbatim | Modifier |Comment
1[311447355 64 2813.09W -31. 246436 -64 470304
*
J—
Determination Source: |Google Maps (map data 2020): MaNIS Georef . Calculat E Radius (Verbatim}{ Probabilty: | Search Look-
Determination Method: |Geu:urefereru:ing Quick Reference Guide, Version 2012 i Radius [Numeric}:|18iE.EEE i q-!m | U p L1 st
Determined By: |F‘erscun - L. Li {Lin Li); Collector, Project Manager, Geare [+ Genmetr'_.':| Datum:|[IEEER s be fore
Determination Date: |'|'| Mar 2020 Derive Centroid: {~ System " User Prefemad: |TE!$ | enter i ] g a
Centroid Latitude (DMS): | Dec.: | Centroid Longitude: Dec. | _new Datum
Motes:

LatitudeLongitude List
Determination Source Centroid Latitude (OMS) Centroid Longitude Prefemad

I Google Maps (map data 2020); MaNI5 Georef. Calculator _— Yes

Google Maps/Earth,
GEOLocate, BingMaps all use
WGS84 (universal world

Localty Lat/Long Mapping J Motes ] Muttimedia ] Security ] Byt
Edit Stte 23 of 6831

geodetic datum)



NOTES

File  bdit  select  View  lools  labs  hulimedia  Window  Help

DE® &5 &5y M4 > B @ s
|South America. Argentina. Cérdoba. Vicinity of Cosquin, Cérdoba | 1400388
LatitudeLongitude Details
Latitude (DMS) | Longitude (DMS) Latitude (Dec.) | Longitude (Dec ) | Latitude Verbatim | Longitude Verbatim |Modifier |Comment |
1|3114 47355 64 281309 W -31. 246486 54 470304
]
Determination Source: |Gc|clgle Maps (map data 2020); MaNIS Georef. Calculat i Radius I_"-.-"erl:uatim}:| F'n:ul:ual:uil'rt'_.':l
Determination Method: |Geu:ureferenn:ing Quick Reference Guide, Version 2012 i Radius [Numenc}:|18£E.EEE Lln'rts:lm j
Determined By: |F'ers-:un - L. Li (Lin Li}; Collector, Project Manager, Geore Gec.rnetrg,-:| Datum:l';".-'GSEi j
Determination Date: |'|1 Mar 2020 Derve Centroid: {— System 1+ Lser Preferred:l‘fes ﬂ
Centroid Latitude (DMS): _| Dec. Centroid Longitude: Dec..|
Motes: Georeferenced to the center of Cérdoba.

LatitudeLongitude List
Detemination Source Centroid Latitude (DMS) Centroid Longitude Prefemad

Google Maps {map data 2020); MaNIS Georef. Calculator | [ves

Record any assumptions made or and deviations from
the guide (with concise explanation).
Or, note why it was NOT georeferenced.




LIST VIEW

- By default, every module - You can create your own List
displays Summary Data in View by going to View->List
List View. V1ew—>Qhoqse List

- To change the columns that and clicking on New.
appear 1n list view, go to - Select the fields to add to
View->Columns->Select View yvour new List View.
or right click on the window Field Properties
and select Choose List.

Height: I?

(L0 Fields... - [ Fields:
o=l &lw e A A
Title Owner | P garccude% IEOI:uject Details}-}
.m tulig . arcode: (Tissue Sample X W
Date fields tulig S—
DC taxonomy tulig Barcode: (Collection)
efault Liz Emu o
ge;crir;_iu: W i.EltSIJI'I J
e o i 0
[ New... \/ oK f|_ Close ? Help Remove | Clear
o OK ‘ xCancel‘ ? Hep ‘ LiSt VieW



https://sweetgum.nybg.org/wiki/index.php?title=Summary_Data
https://sweetgum.nybg.org/wiki/index.php?title=List_View

Search for the records you would

like to save

From the Menu Bar

select Tools>Group>All Record in

Results

Click on the New
left hand corner
box that appears

Another dialogue

icon in the lower
of the dialogue

box will appear

showing you the type of group you

are creating and

the number of

records you are grouping. Give your

group a name.

Group Properties...

GROUPING RECORDS

General l Security ]

[,
|F‘.eu:u:|rdst-:| gruup|

Created:

Modified:

Tue=sday, July 21
Tuesday, July 21

o 0K

How to Group Records

.l

Description:

Purpose: |

Status: | Group Properties...
General Security l

IRN:

Type: Static % Title:

Records: 7 Cwmer:

Owner: tulig Names:

Records to group
tulig

ﬁ volunteer
€ Volunteer

€ vrivera
€ warder
3] watson |
4

AcCcess:

I

ﬁ tarnowsk

€ tulig
€ watson



https://sweetgum.nybg.org/wiki/index.php?title=How_to_Create_Groups_of_Records

SORTING

Run a search to find the
records you want to sort.

Select Tools—>Sort (Alt + T +
T) or click on the Sort icon

The Sort box displays with
all available sort options.

You an also create a new Sort
with specific fields you are
interested in sorting by

i

L Sort — ==

sENESEE

Title Owner | -

lscenitic nane |

%l Scientific name DwC tulig

%l Structural botany: barcode number tulig

%l Structural botany: container title tulig

%l Summary Data tulig

%l Tiss Preparer tulig

%l Tizsue Sample barcode tulig

%l Tizsue Sample Collector & Mumber sort tulig

%l Type Status watsan

£ Tvoe taxon tulio i
i O New.. W OK H Close ? Hep

=

How to Sort Records



https://sweetgum.nybg.org/wiki/index.php?title=How_to_Sort_Records

